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WHAT DOES IT DO?

Dropout refers to a visual disruption such as pixelation, flickering, or freezing that occurs in video footage due
to missing or corrupted data in specific frames or areas of the image. It manifests as brief interruptions or
gaps in the video signal, where portions of the image are temporarily lost or distorted.

Dropouts can be caused by various factors, including transmission errors, damaged tapes, storage or
encoding issues, or even inherent limitations of the recording equipment.

DVO Dropout + Fix will fix all your Head problems and tape drops, big & small, Luna & Chroma, with the added
power to repair specific areas and imperfections in a single frame through the addition of our Fix tool. Fix
repairs artifacts like scratches, hairs and blotches and larger damage like punch holes, film tears and full
frame reconstruction.

Using a brush or shape tool to select the damage, Fix automatically repairs the selected area by comparing it
to adjacent frames and applying motion compensation to recreate missing detail plus grain compensation to
blend in the recreated information.

HOW DO YOU USE IT?

DVO Dropout + Fix works on the following platform:

@ PHOENIX

Restoration & Color

If you're already a Filmworkz veteran, you can jump right in and use DVO Dropout + Fix however if you need a
hand with anything, our friendly Al assistant Juno is your first port of call. Whether it's guidance with DVO
tools, help getting started in Phoenix or Nucoda, access to the latest versions or discovering best

practices, Juno offers instant, accurate support, any time you need it - that's 24/7 because Juno never sleeps!

GETTING STARTED

1. Launch Phoenix on your workstation.

2. Locate the toolbar, (positioned on the left-hand side of 3. Scan the toolbar options until you
the interface) find the DVO Dropout + Fix tool.

DVO Convert
DVO Video > DVO Aperture
DVO Film *| DVO Deinterlace

DVO Dropout+Fix

Colour Tools > DVO Chroma (H) c 5 [ e
Colour Management > DVO Cross Colour
Composite *| DVO Dropout

Image Effects > DVO Dropout+Fix

C'Base (CC Layer)
(% master

4. Click on it and the control panel under appears:
B Effect T Tracker D Scene Detect B Caches
DVO Dropout Processing Enable Adaptation Black Scene Change: Inside
DVO Fix Setup Adaptation Enable Black Signal: Y
Filter: Mixed 4 Mation 30 Fixed Threshold
Filter Size 3 MDC White

Edge Enable White

Temporal Adaptation Fixed Threshold



https://junoknows.ai/
https://junoknows.ai/
https://filmworkz.com/phoenix/

CONTROL PANEL EXPLAINED
DROPOUT TAB

FILTER

SPATIAL / TEMPORAL / MIXED FILTERS

Filter: Mixed 4

The filters used by the process are very important in determining the final processed quality. DVO Dropout
includes a variety of filter algorithms that can effectively process a wide range of input footage.

The following generic filter groups are defined.

Values: Spatial, Mixed 1, Mixed 2, Mixed 3 (default), Mixed 4, Temporal 1, Temporal 2, Copy Prev, Copy Next,
Bypass

All filters named Spatial are filters that work only within the current
SPATIAL: field i.e., it has taps only in the current field.

These filters are intended for very small spots.

All filters named Mixed have taps in both the current field, the frame
before and the next frame i.e., it has both spatial and temporal taps.
All these filters, however, have more taps in the current fields than
in the previous and following frames together (more spatial taps

MIXED: than temporal).

These filters are intended for normal dropouts.

The different Mixed types (Mixed 1,2,3 etc.) change the ratio
between spatial and temporal. The larger the number, the more
temporal filtering.

Temporal filters have both spatial and temporal taps but with more
temporal than spatial. This will enable DVO Dropout to remove any

TEMPURAL size of drops.

These filters may need more careful use to avoid unwanted
artefacts.

FILTER SIZE

This sets the size of the filter on the current field, so it's only required for spatial and temporal filters. Use the
numeric slider to define the filter size.

The optimal size of dropout filter size is 3
Range: 0-15
Default: 3

)



ADAPTATION

Adaptation

This toggles Adaptation on/off.

When off, DVO Dropout works in global mode and filters the whole image with the same fixed filter selected in
the Filter menu.

MOTION

Motion 30

This numeric slider configures the level of motion sensitivity.

Initially you can set it to 0 (safest), for maximum motion sensitivity, and then increase it in steps if there isn't
enough filtering in moving parts of the picture. A value of 256 corresponds to no motion adaptation at all,
meaning that temporal filtering can be fully applied to moving parts of the image.

If there is motion on the pixel that you want to process, a value of 0 will disable processing and a value of 255
will allow it. The values between will allow less or more motion to be processed.

Range: 0 - 256
Default: 30

MOTION DETECTION CURRENT

The MDC (Motion Detection Current) toggle button will do the following:

e Look at just the previous and next field, or
e Look at previous, next and current field.

Having this option enabled ensures a higher sensitivity level and reduces artefacts to a minimum. For
maximum filtering, the control is disabled.

If you start seeing visible artifacts from processing, enable MDC.

EDGE

This controls the image’s edge protection.

Edge protection acts as a safety measure and reduces the possibility of false detection. Some material may
require this protection; for example, houses at a distance, a forest or material with a slight weave.

By turning edge protection on, the built in edge detector will affect where DVO Dropout will filter, and it'll reduce
filtering where it finds edges.

TEMPORAL ADAPTION

Temporal Adaptation works by excluding falsely detected dropouts from being processed. It does this by
comparing dropouts detected on the current field with dirt detected on the previous field (within a sizable

window).
¢

For static dropouts like head clogs, Temporal Adaptation needs to be in off mode.



BLACK / WHITE

Enable Black

Fixed Threshold 20

White
| Enable White

Fixed Threshold 20

There are two separate and independent parameter groups controlling the processing for Black (dark) and
White (light) areas (or in chroma mode, high or low U or V levels).

White/black dropout removal can be enabled via the corresponding toggle button.

Note that if neither button is enabled then DVO Dropout will do no filtering at all.

FIXED THRESHOLD

Fixed Threshold 20

You should lower the thresholds if you have very low contrast white dropouts on light background, or black
dropout on dark background, and increase the thresholds if the luminance difference between the dropouts and
the background is less apparent.

Set the threshold lower. Set the threshold higher.
Range: 0 - 63
Default: 20

SCENE CHANGE

Scene Change: Inside

This dropdown gives you options for how to process the frames surrounding an edit/cut point:

Inside:  Processes the field before a cut using only the current and previous field and processes the field
after a cut using only the current and next field. Stays inside the shot. This is the default.

Across: Ignores cuts, use the previous, current, and next frame. It processes across shots.

Bypass: Doesn't process the frames before or after a cut.



SIGNAL

This selects the signal (channel) within which a dropout will be detected.

The detection works on one channel only, normally 'Y'. By setting the signal to 'U', for example, when only U
dropouts are visible, DVO Dropout will detect the chroma dropouts better, minimizing the risk of affecting
actual picture content.

Values: Y,U,V,R,G,B,Y+U+V
Default: Y

SETUP

VIEW

WAiew

Wiew Mode: Dirt On Luma

Turning on the View toggle button will provide an overlay/preview showing the areas detected. The type of
overlay can be selected via the View Mode dropdown list (below).

VIEW MODE

Wiesy Mode: Dirt On Luma
o hdode: Dirt On Red Input
Il irt ut

ference

Choose the desired mode to view the dropouts:

Dirt on Luma: The detected dropouts are highlighted on a monochrome input picture with lowered
luminance. This is the default.

Dirton Red Input:  The detected dropouts are shown with red on the unprocessed input signal.
Dirt on Red Output: The detected dropouts are shown with red on the processed output signal.

Difference: The difference between the unprocessed input and the processed output is displayed.

HISTORY REQUIRED

History Req

DVO Dropout works recursively. This means the result on any one frame depends on previous frames.

For the best results a certain amount of frame history needs to be built up. This numeric slider is used to
specify how many frames of history to use.

Range (frames): 0 — 15
Default: 5
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USE HANDLES

Use Handles

Use Handles controls whether the history includes available handles of a scene/shot.

Normally, the history frames accumulated will end on a shot edit/event (start/end edit). However, there may be
extra frames available (handles) before or after the start and end editing points and these will be included as
history if Use Handles is enabled.

If handles exist, full and precise processing will be available from the first frame of a clip.

MAX FILTER

Max Filter
Enahle
Filter: Termparal 1

Enable Max Filter to add a second filter (in addition to that in the Processing tab).

FILTER

Filter: Spatial
Filter: Mixed 1
ed 2

Filter: Mixed 3
Filter: Mixed 4
Filter: Temporal 2
Filter: Copy Prev
Filter: Copy Next
Filter: Bypass

Use this dropdown to select the maximum filter to process large dropouts.

When the Max Filter is enabled, the normal filter used for the adaptive filter sizing will take care of the small dirt.
When the upper size limit is reached it'll automatically switch over to the filter selected here.

The filter used here would typically be a larger temporal filter.

Values: Spatial, Mixed 1, Mixed 2, Mixed 3, Mixed 4, Temporal 1 (default), Temporal 2, Copy Prev, Copy Next,
Bypass

SIZE

This specifies the size of the spatial part of the filter (for spatial and mixed filter types).
Range (frames): 0 - 15
Default: 3



MOTION

WIDTH

rotion

Wicith

Motion Width is used in combination with the Motion control in the Processing section and defines the motion
adaptation behavior.

Zero - When Motion Width is set to 0, the motion setting will be used as a threshold, discriminating between
moving and non-moving parts.

Non-Zero - When Motion Width is set to a non-zero value, the classification will change gradually from “no
motion” to “full motion”. Motion width then specifies the size of the transition region.

Range: 0 — 255
Default: 30

MDC SCALE

MOC Scale

The MDC (Motion Detection Current) toggle button in the Processing section determines whether to look at just
the previous and next field/frame, or to look at all the previous, current, and next field/frame.

The higher the MDC Scale setting, the more filtering is applied (less impact of the MDC algorithm).
This is only used if MDC (Motion Detection Current) control is enabled in the Processing section.
Range: 0 - 15

Default: 8

TEMPORAL

The purpose of temporal adaptation is to exclude false detection from processing by comparing it with the
detection on the previous frame within a sizable window.

STRENGTH

Stremngth

Strength level determines the amount of influence that the detected dropouts on the previous frame will have
on the exclusion of dropout detection in the current frame.

A higher value will result in more dropouts being excluded and less processing carried out.
Range: 0 — 255
Default: 80



TRIM SIZE

Trim Size

The Trim Size corresponds to a "window" in the previous frame which is searched for dropouts to compare
against the current frame. The smaller the window (trim size) the more filtering will be achieved.

Range: 0 -7
Default: 5

HIT GROWTH

The Hit Growth control is useful when the dirt in the image doesn’t have well-defined edges.

By increasing the hit growth, the processor is told that the dropout is bigger than it appears. The result is that
the soft edges also are processed.

RELATIVE

Relative 3

In relative mode, large dropouts cause a larger growth.

The Relative slider controls the amount of hit mask growth. The higher the value, the larger the area around the
dropout will be processed.

Range: 0 — 15
Default: 3



BRUSH MENU

The brush tool appears in the viewer as an oval shape. Use this tool to fix an area by either clicking or
clicking and dragging the brush.

SIZE

The size tool allows you to resize the brush in order to fix smaller/larger areas.

You can also resize the brush by holding down the SHIFT key (on either the keyboard or control panel), the left
mouse button and dragging.

Range: 0.1 - 5000
Default: 20 pixels

RAT

Rate 10.00c

The rate tool applies to when you drag the brush, affecting how many brush 'stamps’ are performed during the
dragging motion.

Range: 2 - 1000
Default: 10

RECT MENU

The rectangle tool displays a crosshair in the viewer, allowing you to draw a rectangle around the area that you
want to fix. As soon as the rectangle has been drawn the DVO Fix effect will start processing.

SOFTNESS

Softness 0.200

The softness setting applies to the border outside of the rectangle and allows you to adjust how the outline
blends into the surrounding area. This numeric slider takes values between 0-1.

Range: 0.00 - 1.00
Default: 0.2



COMMON MENU

IJse Handles

The Use Handles button controls whether the tool uses source handles when rebuilding the frame. This is
important at scene boundaries (edits) because the tool rebuilds using frames before and after the current
frame.

If this button is on, and we're at a scene boundary (start or end of shot), if we have handles, we will use them as
part of the rebuilding process.

If there are no handles, or this button is off, no frames before or after will (or can) be used at the scene start (or
end), and this impacts the DVO Fix result.

Tip: You can change the type of cut when you have a scene-detected longplay/
mixdown file by clicking on the toolbar at the bottom of the interface & altering th ch = g fa
the type of cut (scene cuts and edit cuts) to use handles when necessary.

ERASE

The Erase button becomes enabled as soon as a fix is made to the current layer.

Turning on the Erase button will turn the brush into an eraser and applying this to the fixed area of your image
will 'undo’ previous fixes.

You can't erase changes made to a mixed-down layer.

MIXDOWN

fliz Do

The Mix Down button becomes enabled as soon as a fix is made to the current layer.

Pressing Mix Down will make the changes to the current layer permanent, "burning” them into the image.

This tool allows you to apply fixes with different settings to the same area.

ENABLE GRAIN

Enable Grain

Enable Grain will turn on the grain compensation. This adds grain to the 'fixed' area as appropriate, blending the
changes into the scene. The default setting is off.

The parameters are the same as the DVO Regrain effect.

COLOR

“Colour: Linear (SMPTE)

The drop-down list will default to the project setting for the input format. You need to set this control according
to the material that you are working with. If the footage was shot with a video camera, select a linear format. If
this control is not set correctly the material may not be processed properly.
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https://junoknows.ai/login
https://filmworkz.com
mailto:sales@filmworkz.com
https://www.linkedin.com/company/filmworkz/
https://www.facebook.com/wearefilmworkz
https://www.instagram.com/wearefilmworkz
https://www.youtube.com/@wearefilmworkz
https://letterboxd.com/WeAreFilmworkz/
https://vimeo.com/filmworkz
https://x.com/wearefilmworkz
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